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1.  Search Screens 
 Patient Search screens – all patient searches will now take middle initials into account when alphabetizing 

the search list. 

 

 New method added to select multiple records in search windows. 

o Applies to searches like Patient, Insurance Carrier, CPT, etc. in screens where the user is allowed to 

select more than one record.  

o User can now hold down SHIFT and use the UP or DOWN arrows to select additional consecutive 

records. 

o Previously user could only use the mouse to click on each record. 

o Keep in mind that this is not the same as the standard Windows “SHIFT+click” functionality, that is 

used to select a range of items.   

 

  button added to the bottom of most search screens. 

o Applies to searches like Patient, Insurance Carrier, CPT, etc. in screens where the user is allowed to 

select more than one record. 

o Will select the records currently displayed in the search results area. 

o Can select up to maximum of 1000 records. 

 

 Multiple Select search screen added to search filters: 

o Added in following screens: 

 ePrescription Tracking – Activities>ePrescription 

 Diagnostic/Lab Order – Activities>Diagnostic/Lab Order 

 Authorization Tracking – Activities>Authorization Tracking 

 Referral Tracking – Activities>Referral Tracking 

 Eligibility Tracking – Activities>Eligibility Tracking 

 Marketing (Cosmetisuite & Non-Cosmetisuite)- Activities>Marketing 

 Photo Query (Cosmetisuite) – Activities>Cosmetic>Photo Query 

 Missed Shot Followup (Immunotherapy) – Activities>Immunotherapy>Missed Shot 

Followup 

 Print Forms (To be filled) – Utilities>Print Forms (To be filled) 

 Patient Special Search – Utilities>Patient Special Search  

o Fields that are affected in these screens will no longer have a drop down list format. 

 Field background color will be blue. 

 “(?)” will be at the end of the field label. 

o To activate search window user can: 

 Click the field label. 

 Click the “(?)” at the end of the field label. 

 Click cursor in the blue area of field and then press F5. 

o In the Search window, the search results area has two sections: 

 Left side will show results of search. 

 Click one or more line items to select 

 Hold down Shift and press UP or DOWN arrows to select multiple 

consecutive line items. 

 Select All / Deselect All options provided 

 Click the arrow to move it to the right side. 
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 Right side lists all items that have been selected. 

 To remove items from right side, click to select item(s), then click the Clear Selected 

option. 

 Hold down Shift and press UP or DOWN arrows to select multiple 

consecutive line items. 

 Click the Clear All option to remove all items from right side. 

 

2. Patient Special Search 
 Age – when searching using the In DOB option, system will now disregard the year, and only search 

according to the Month & Day. 

o Ex:  Selecting dates From: 04/01/10 To: 04/30/10… will show all patients born in April, regardless 

of what year they were born. 

o Caption at top of results has been changed to reflect this. 

 

 User can now select more than one Insurance in the left side panel. 

o Press F5 or click the “?” in the Insurance field and “Select Insurance Plan” window will open. 

o The search results area has two sections: 

 Left side will show results of search. 

 Click an insurance to select it, and then click the arrow to move it to the right side. 

 Right side lists the selected insurances. 

 

 Vitals criteria added – user can add search criteria based on a vitals reading. 

o Vitals section added to left-side panel: 
 

 
 

 For date entry, use the drop down to specify Before, After, or Range, and then enter the 

appropriate dates. 

 Use the “Check last entered vital” checkbox if the search should only look at the last vitals 

entry for the selected period. 

 Select the appropriate Vital Sign reading and operator (>=, >, <=, =, etc.) from the drop 

down lists, and then enter the number value. 

 Select the “Not Taken” option, in the operator drop down, to search for patients who 

did not have this particular vitals reading taken in the selected period. 

 If listing more than one vital sign criteria, select the appropriate conjunction between each. 

 And – patient must match both of the vital sign criteria. 

 Or – patient must match at least one of the vital sign criteria. 

 Up to 4 vital sign criteria can be listed. 
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 Lab Results criteria added – user can add search criteria based on a lab result. 

o Lab Results section added to left-side panel: 
 

  
 

 Code Type –  

 Leave blank to select un-coded (non-HL7) lab results. 

 Choose a specific ID type to select a coded (HL7) lab result. 

 Lab items are coded in Setup>Visit Note>Diagnostic/Lab Test 

 Result – select the appropriate lab test, based on the ID type selected above. 

 Although the search screen for the result allows multi-selection, only one lab result 

should be selected in each Result field. 

 Up to 4 lab results criteria can be listed. 

 Select result criteria. 

 Type - Character or Numeric 

 Comparison operator – Like, Equals, Not Ordered 

­ Select the “Not Ordered” option to search for patients who did not have this 

particular test ordered in the selected period. 

 Value – enter the search value 

 If listing more than one result, select the appropriate conjunction between each. 

 And – patient must match both of the vital sign criteria. 

 Or – patient must match at least one of the vital sign criteria. 

 After listing the lab result criteria, return to the top of the Lab Result section for date entry.  

Use the drop down to specify Before, After, or Range, and then enter the appropriate dates. 

 

 Save Criteria feature replaces Save/Load Query buttons. 

o Fill in the search criteria that should be saved for use in future searches, and then right-click 

anywhere in the blue area (that is not an actual field) of the left-side panel. 

o If there are no previous searches saved, the user will see:   

Click this to open the “User Defined Criteria” window. 
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 All the criteria that were entered in the left panel will be saved in the search. 

 User must enter a name for the search in the Description field. 

 Since dates entered in the left-side panel are not saved, if a user wants to have a particular 

date or date range for one of the fields saved in the search, they can use the From/To fields in 

this screen to store the date criteria. 

 Check the All Users box, to make search available to all users. 

 Check the Default box to have this be the default search criteria that will be loaded 

automatically when the “Patient Special Search” screen is opened. 

 Click Ok to save the search. 
 

 
 

Criteria selected in the left-side panel 

will be stored in the saved search. 

To save dates/date 

ranges for specific 

fields, enter them in 

this window. 

User must enter a Description to serve 

as the name of the saved search. 

Click Reset to 

erase all data that 

has been entered. 
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o Once there has been at least one search saved, right clicking on the screen will display this type of 

menu: 

 
 

 Section 1 – all saved searches (except the one currently loaded) will be listed here.  Click a 

saved search to load its criteria into the left-side panel. 

 Section 2 – Options for the currently loaded search.  Here you can Reselect Criteria, Delete 

Criteria or Update Criteria for the currently loaded search. 

*selecting the Delete option here will delete the saved search entirely. 

 Section 3 – Save As allows the user to save a completely new search using the criteria 

currently selected. 

 Section 4 – Manage User Defined Criteria opens the “User Defined Criteria” window: 
 

 
 

 Use the Seq. No. column to put the searches in the order they should appear on the 

right click menu. 

 Use the D column to designate a default search that will load automatically when the 

“Patient Special Search” window is opened. 

­ Default checkbox can only be checked for one saved search. 

 Put the cursor in the search name, and click the Delete button to delete a saved search. 

 Click Save, and then Close, to save changes and exit the window. 
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3. Chart View 
 Option added to have Patient Alert window open in Chart View. 

o Setup>System Parameters>Other>“Show note/reminder alert in chart view” 

 When set to Yes the standard “Patient’s Alert” window will open when the patient is selected 

in Chart View screen, if the patient has any active alerts. 

 

 Chart View layout has been changed. 

o New information area, with seven sections, at the top of the “Chart View” screen. 

 Patient Picture (if no patient picture has been added, the section will be blank)  

 DOB, Age, Gender, Race 

 Address, Home Phone, Work Phone 

 Last Visit, Next Appt., Balance 

 Insurance – double click in this section to open Insurance screen. 

 Allergy 

 Note 

o “Edit Patient” button has been moved to the title bar above the tabs. 

o Chart View screen will now open to the “Document” tab by default. 

 

 Patient Notes, Reminders and Appointments can now be printed/faxed from the History tab.  

o 3 new System Parameters:  select the letter template to use for each from the drop down lists.  

Setup>System Parameters>Other 

 Reminder letter for Print/Fax from Chart View>History 

 Drop down list will show only letter templates of Type = Reminder/Note. 

 Note letter for Print/Fax from Chart View>History 

 Drop down list will show only letter templates of Type = Reminder/Note. 

 Appointment letter for Print/Fax from Chart View>History 

 Drop down list will show only letter templates of Type = Schedule. 

o History tab – added two buttons. 

 Print 

 Fax 

o The “Visit Note” field will be included in the Reminder print out only when the reminder is linked 

with a Visit Note or Billing.  If it is not linked then it will print the “Provider” from the Patient 

Master record and the logged in user’s default “Office”. 

o The patient Note print out will not print visit note related fields as a patient Note cannot be linked 

with a visit note. Since there is no provider linked with a patient Note, it will be taken from the 

Patient Master record. 

 

 Export button added to the Document and History tabs. 

o Click the Export button to export the selected items to be saved in a file location outside of IMS. 

 Document tab – will export any selected document (box checked). 

 History tab – will export only Documents, Visit Notes, Notes, Reminders and Appointments. 

 Default letter template must be set for Notes, Reminders, and Appointments in 

Setup>System Parameters>Other (as seen in last change listed above). 

 If default letter template has not been set, user will receive a warning message.  
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o Export window will open: 
 

 
 

 Click the Select Folder icon to choose the external directory to which the files should be 

exported. 

 Remove folder if exists – will overwrite any existing folder with the same name in the 

selected folder. 

 Zip exported files – will create a zip file containing all the exported items. 

 Password – check this box to put a password on the zip file.  Password must be at 

least 8 characters. 

o Export process will create a folder labeled with the patient’s name and DOB in the selected file 

location. 

 Ex:  JANE DOE-04081985 

 

 Reminder Tab 

o Eliminated the two section (Generated Task & Task Definition) layout. 

o Added two drop down fields at the top: 

 Show – Reminder, HM (Health Maintenance), Both 

 View – Generated Task, Task Definition 

 Only applicable when “Reminder” or “Both” is chosen in the Show drop down. 

 

 Filter and/or button changes to some chart view tabs. 

o Document tab – added/removed buttons. 

Added: 

 Printer – select printer. 

 Print – printed selected document(s). 

 Fax – fax selected document(s). 

 Add/Edit/Sign Off – opens the “Patient Document(s)” window. 

Removed: 

 Add/Edit or Print/Fax Document 

o Authorization tab – added the “Add/Edit or Print/Fax” button. 

 Clicking this button will open the “Authorization Tracking” screen for the current patient. 

o Referral tab – added the “Add/Edit or Print/Fax” button. 

 Clicking this button will open the “Referral Tracking” screen for the current patient. 

 

 History tab – search fields added. 

o From/To Dates 

o Case 

o Filter History button – click this button after setting the filters to search for matching history 

records. 
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4. Patient Master (F2) 
 Added the ability to have the “Make as permanent Address” checkbox default to being checked. 

o Setup>System Parameters>Other> 

[Make as Permanent Address] should always be checked in Patient Demographics 
 Yes – “Make as permanent Address” checkbox in “Patient Master” screen will be 

automatically checked. 

 This parameter’s default setting is “Yes”  

 

 Other Options icon added to right side panel. 

o Photo Album, Gluco Meter, Portal Login & Appointment Call options have been moved to this 

icon. 

o Only those options turned on via their associated parameters will be listed under this icon. 

 

 Photo Album feature from Cosmetisuite is now available in standard IMS. 

o Photo Album option can be turned on via the related system parameter, even if Cosmetisuite module 

is turned off. 

 Setup>Modules/Features> “Allow Patient Photo Management” 

 If set to Yes, photo album can be accessed from: 

 “Patient Master” screen>Other Options icon in right-side panel>Photo 

Album menu option. 

 Walley icon>Photo Album 

 

 Patient Portal login – ability to create a patient login for the portal, from “Patient Master” screen. 

o Click the Other Options icon in the right-side panel and select Portal Login. 

 This will open the standard “Patient Portal>Login/Email” screen, that is normally opened 

from Utilities>Patient Portal>Login/Email. 

 

 Phone (H) # and Phone (W) # - the section for the extension will now allow up to 10 digits.  

 

 Pref. Comm. (preferred communication) field added to designate the way the patient prefers to be 

contacted. 

o Drop down list includes:  Phone, Mail, Fax, Email. 

o Added Pref. Comm. column in “Patient Special Search” screen in the search results area. 

 

 Cellular # field – drop down section added at the end of this field to allow user to specify a cellular carrier 

for SMS/texting purposes. 

o Drop down will only appear if internal parameter K01 (SMS/IVR) is set to “Yes.” 

*This must be set by IMS support. 

o Drop down contains:  Alltel, AT&T, Nextel, Sprint, SunCom, T-Mobile, Verizon, Voice Stream 

 This list is hardcoded and cannot be added to. 

o If a cellular number is entered here, it will also show at the top of the “Check In” window when 

checking in a patient. 

 If cell number has no asterisks at the end, this means there is a carrier already selected in 

Patient Master. 

 If cell number has two asterisks (**) at the end, this means there is no carrier selected in 

Patient Master. 
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 User Defined Columns has been changed to Custom Fields. 

o “Patient Master” screen>Custom Fields icon in right-side panel. 

 Renamed from previous User Defined Columns icon. 

o Setup>Admin>Custom Fields 

 User Defined Columns menu item has been renamed to Custom Fields. 

 

 Hot Keys – added two new hot keys in the “Patient Master” screen. 

o Alt + I = opens “Patient Insurance” window. 

o Alt + C= opens “Patient Contact(s)” window. 

 

5. Scheduler (F9) 
 Find Available Slots – expanded capability to search for available appointment slots. 

o Click the “Search” button  in the Scheduler screen to open the “Find Available Slots” window. 

 

 
 

o Features added include: 

 Selection fields for Date, Office, and Provider/Room. 

 Click the  icon for the Office and Provider/Room fields to open a multi-select 

search screen.  

 Any Office, Provider/Room checkbox can be checked to search based on all Offices, 

Providers, and Rooms. 

 Select Procedure and minutes. 

 [Skip slot, which is not reserved for selected procedure] option will appear only 

when a specific procedure has been selected. 
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 Select number of next available days to show. 

 Select maximum available slots per day. 

 Show By – group available slots by either Provider/Room or Date. 

 “Check Slots” button.  

 Click the “Check Slots” button to see the list of appointment slots matching the 

criteria entered. 
 

 
 

 Date, Time, Duration and Note will be shown for each appointment slot. 

 Time slots and duration shown is determined by the provider’s settings in 

Setup>Scheduler>Provider Availability. 

 Slots that show “Appointment booked” mean this slot is already scheduled for 

another patient. Users can still select this slot and double book the new appointment. 

 If a slot is “Not Available” or “Blocked,” it will not be shown on the list. 

 Slots that are “Reserved,” will show the reserved details, and the user can select this 

slot to book the appointment.  Only the procedure(s) that this slot has been booked for 

will be available to select for the appointment. 

 To schedule the appointment, click a time slot line to select it and then click the “Set 

Appointment” button, or simply double click the time slot.  Fill out the “Schedule 

Entry” window with the appropriate information. 

 Based on the results of the time slot search, if any of the criteria needs to be changed, 

the user can click the “Go Back to Check Slot” button to return to the initial “Find 

Available Slots” window. 
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 Lower Left Panel changes: 

o Provider/Room list – now shown as full scrollable list instead of a drop down list. 

 List now has checkboxes for selection. 

 List will default to a single select, however, user can check the “Allow Multi Select” 

checkbox at the bottom of the list, to enable the ability to select more than one 

provider/room. 

o Appointment Detail section – moved to the bottom of the screen below the actual schedule. 

 Appt. Type (Cosmetisuite) now shown in the appointment details. 

o Color Legend – will now be optionally displayed in a section below Appt Details, based on a 

parameter setting. 

 Setup>System Parameters>Schedule>Show Legend 

 Yes – color legend will be shown in a section below the Appt. Details at the bottom 

of the screen below the actual schedule. 

 No – color legend will not be shown, but can be accessed via the Right-click Menu 

or Option button. 

 

 Remove Chart # in appointment list.  

o Setup>System Parameters>Schedule>“Remove Chart# and Show Procedure first in Scheduler” 

 Yes - Chart Number is no longer displayed after patient name, on appointment entry, in 

Week, Month, All Provider, All Office and All Room views. 

 Will still be shown in Daily view. 

 No – Chart Number will be displayed on appointment entry in all views. 

o When this parameter is set to “Yes”, Procedure will be shown right after Patient Name. 

o If Cosmetisuite module is turned on, Visit Type will also be shown. 

 Visit Type is a required field when this module is turned on. 

 

 Move Copay column – moved Copay column further left in the column order, so that the user does not 

have to scroll right to see it. 

o Scheduler>create new appt>Schedule Entry window – in the insurance section at the bottom. 

o Check In/Out>Walk In – in the insurance section at the bottom. 

o Activities>Diagnostic/Lab Order>Retrieve records>mouse over  icon>Insurance popup window. 

o Activities>Drug Dispense>Retrieve records>mouse over  icon>Insurance popup window. 

 

 Copy Template – ability to copy a schedule template for a provider and/or room. 

o Setup>Scheduler>Template 

o “Copy Template” button added at bottom of screen.  Click this button to copy the selected template. 

 Type the name for the new template in the “Enter Description” field that pops up. 

 System will default in the name of the original template plus “Copy -” at the 

beginning. 

 To change the default name, just delete it and type a new name. 

 Click the “Ok” button to create the template copy.  
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  Paste Multiple - Ability to paste a copied appointment into multiple date/time slots at the same time. 

o “Paste (Multiple)” option added to the right click menu. 

o “Paste (Multiple)” window: 

 From/To dates – enter the date range in which to paste the multiple appointments. 

 From/To time – enter the time slot in which to schedule the appointments. 

 Click “Add” to add the time slot to the “Slot(s)” list on the left. 

 Enter and add as many time slots as needed 

 Highlight a time slot and click “Delete” to remove it from the “Slot(s)” list. 

 In the bottom section, select the frequency (every day, week, month or year) and its 

associated settings, for the repeating appointment(s). 

 At this point if the user clicks the “Close” button, the system will not paste the appointments.  

The user must click the “Check Slots” button to be able to set the appointments. 

 

 
 

 
 

 Use the “Check Slots” button to check the availability of the time slots specified. 

 Date, Time, Duration and Status will be shown for each appointment slot. 

 Time slots and duration shown is determined by the provider’s settings in 

Setup>Scheduler>Provider Availability. 

The top of the window displays 

the duration of the appointment 

being copied. 

An asterisk will be 

displayed next to any 

time slot that doesn’t 

match the duration of the 

copied appointment. 
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 Appointment slots that are “Available” will be automatically selected, according to 

the duration of the copied appointment. 

 Slots that show “Appointment booked” mean this slot is already scheduled for 

another patient. Selecting this slot will double book the slot with the copied 

appointment. 

 If a slot is shown as “Not Available” based on the provider’s availability settings, the 

user can still select it to override and set the copied appointment. 

 Slots that are “Blocked,” “Reserved,” or “Appt. booked for same patient” cannot 

be selected. 

 Double click any time slot to open another Scheduler screen to that date.  When 

finished viewing, close this additional Scheduler screen to return to the “Paste 

(Multiple)” window. 

 Check the box next to each appropriate time slot and click the “Set Appointment” 

button to schedule the copied appointments and close the “Paste (Multiple)” window. 

 Based on the results of the time slot search, if the date range/interval/frequency needs 

to be changed, the user can click the “Go Back to Check Slot” button to return to the 

initial “Paste Multiple” window prior to setting the appointment(s). 

o Using the “Paste Multiple” function to schedule appointments will not include the checks/prompts 

for Authorizations, Forms to be Filled, Reminders or Instructions as when using the standard method 

of scheduling.  

 

 Action options added for Missed/Canceled appointments. 

o In the “Scheduler” screen, right-click an existing appointment and select Missed, Canceled By 

Patient, or Canceled By Provider. 

o Popup window for all three has been changed: 
 

 
 

 Action section added: 

 None – no additional action will be taken. 

 Add to appointment waiting – adds patient to “Waiting for Appointment” list. 

 Generate Reminder – generates a reminder task. 

 If this option is selected, user will need to select an existing reminder task 

from the drop down list. 

 If Assign To has not already been set up for the task, the user will be 

prompted to select the Assign To. 

 If the appointment is “Reset to Active” or “Deleted” the generated reminder 

will be deleted, if still pending.  
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o 3 new parameters added in Setup>System Parameters>Schedule 

 Default action for canceled by patient 

 Default action for canceled by provider 

 Default action for missed appointment 

For each parameter select the proper default action: 

 None 

 Add to appointment waiting 

 <<select an existing reminder task to have the system default to generating a reminder>> 

o This popup window will also be seen in the “Check In/Out” screen (F10). 

 Right-click on a patient’s name in the left-side panel, and then select Missed, Canceled By 

Patient, or Canceled By Provider. 

 The popup window will not open when user selects the “Mark All No Show as Missed” 

option. 

 

 Change Procedure Office icon added to change office associated to a schedule Procedure without having 

to delete the procedure and re-add it under a different office. 

o Setup>Scheduler>Procedure 

 Change Procedure Office icon  added to the end of each procedure row. 

 Click this icon to open the “Change Procedure Office” popup window. 
 

 
 

 In the Office drop down list, select a specific office or “All.” 

 Click Save and then Close. 

 

6. Eligibility 
 Eligibility – An option to check the patient eligibility by provider or group has been added in the Insurance 

Carrier master screen. 

o New field added in Setup>Payer/Medical Service/Reference>Insurance Carrier 

 Elig. Check By 

 Provider 

 Group 

o The selection made here will determine whether Provider or Group details are sent when the “Send 

Inquiry” option is clicked in the “Patient Insurance” screen. 

 

 Multiple eligibility formats are available for checking eligibility. 

o First, a format needs to be created in Setup>Bill>Insurance Code Master, and associated to a 

clearing house. 

  Add a new entry 

 Type in the format name in the Description field (this will appear on the drop down list for 

the new field in the “Insurance Carrier” screen. 
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 Type an Ins. Code, and select the EMC Format. 

 Select the appropriate Clearing House from the drop down list. 

 Save and Close 

o New field added in Setup>Payer/Medical Service/Reference>Insurance Carrier 

 Eligibility Format 

 Drop down list will contain any format that is associated with a clearing house in 

Setup>Bill>Insurance Code Master, such as AVAILITY, ENS Format, REALMED, 

RCMG, etc. 

 

7. Authorization Tracking 
 Authorization Tracking – view linked document from the Authorization Tracking screen. 

o Setup>Other>Document Category>Option>Add/Edit Category 

 Type - Added “Authorization” to the drop down list. 

o Patient Documents window – if document is given a category that is an “Authorization” type, a 

“Link To…” option will appear next to the Category field. 

 Click this option to open the “Link To Authorization” window. 

 Check the box for each authorization this document should be linked to. 

 Click Ok. 

o “Fax Received” screen – if fax item has a category that is an “Authorization” type, and clicks the 

Autho. Button: 

 Link to selected authorization checkbox will be shown in the bottom left corner of the 

“Authorization Tracking” overlay window. 

 If this box is checked, the fax item will be linked to any selected authorizations, when 

the user clicks Save. 

 
 

 Same process can be used from My Tasks>Fax>View 

o “Multi Scan/Select Documents” screen - if a category is selected that is an “Authorization” type, a 

“Link To” option will appear beneath the Patient field, after the patient is selected. 
 

 
 

 Click this option to open the “Link To Authorization” window. 

 Check the box for each authorization this document should be linked to. 

 Click Ok. 

o “Authorization Tracking” screen – added “View Linked Document” option to the right-click menu. 

 If authorization has document(s) attached, system will open a window to view them. 

 If authorization does not have any documents attached, system will display a message 

stating: “No linked document found” 
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8. Check In/Out 
 Chart View icon – a Chart View shortcut icon  will now be shown at the end of the “Patient” column for 

a checking-in patient. 

 

 Change Room History – new window will display the history of room changes for a patient’s visit, 

including check-in and check-out. 

o “Change Room History” option added to right-click menu. 

 Window will show Time, From Room, To Room and User. 

 The user can select a row and click the “Delete” button to remove a history entry, if needed. 

 The Checked In and Checked Out rows cannot be deleted.  

 

 
 

9. Visit Note 
 Dashboard – users who have not set up a dashboard will now automatically have default dashboard settings 

pulled from the dashboard set up for the System user.   

o This will prevent the user from getting the “Dashboard not set” indicator. 

o Dashboard settings for System user will come already set by default when the system in installed. 

 If these default settings are changed, the revised settings will be used as the default 

dashboard for users created after that point.   

 

  “Room” field added to “Visit Note - Time spent by users” window. 

o Visit Note>Right-side Panel>Options>Time Spent 

o The “Room” column will display the rooms the patient has been in during this visit. 

o The “Start” and “End” columns will show the time frame spent in the room. 

 The times displayed in these fields can be modified, if needed. 

o The “Minute” column will display the number of minutes spent in the room. 
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 Current Medication - Mark as “Patient is not taking any medication” option added.  

o In the Visit Note screen click Current Medication in left-side panel. 

*item could be named differently based on the settings in Setup>Visit Note>Options (Left Frame). 

o In the “Current Medication” screen, click the Add button at the bottom left of the screen. 

 The Mark as “Patient is not taking any medication” option will appear at the bottom of 

the upper panel. 

  This option will only appear if the patient has no current medications. 

*Either the patient has never had any active medication listed, or all active 

medications have been discontinued. 
 

 
 

 When the user clicks this button the system will display a prompt to confirm: 
 

 
 

 Click Yes to confirm, and medication screen will be closed and the user is returned to the 

“Visit Note” screen. 

 The phrase “Patient is not taking any medication” will now appear in the Visit Note text 

under the “Current Medication” header. 
 

 
 

o If the patient has already been marked as “not taking medications” using this feature, the user can 

“un-mark” them in one of two ways. 

1. Prescribe or enter a current medication for the patient and system will automatically un-mark 

this setting.  

2. Return to Visit Note>Current Medication>Add. 

 The bottom of the upper panel will now display an UNMARK option. 

 It will also display the user name, date, and time for when the patient was 

originally marked as not taking any medication. 

 When the user clicks this option, the system will prompt for confirmation (as seen 

above). 

 Click Yes to unmark the setting and return to the Visit Note screen. 
 

 



IMS v14 Release Notes 
 

20 

 
 

 

 NKDA in allergies – users can now click a button in the Visit Note>Allergies window, to mark a patient as 

having no known allergies. 

o In the Visit Note screen click Drug Allergy in the left-side panel. 

*item could be named differently based on the settings in Setup>Visit Note>Options (Left Frame). 

o The new button is located in the bottom left corner of the window. 

o The button text is pulled from the text entered in the existing related system parameter. 

 Setup>System Parameters>Visit Note>No Allergy Clause in Visit Note 

 Text entered in this parameter will appear on the button in the Allergy window, as well as 

being the phrase that will be used in the Visit Note. 

o Click the new button to mark that the patient has no known allergies. 

 If any active allergies are listed, the system will prompt the user with: 
 

 
 

 User can choose to Cancel the action… or click the option to inactivate all current 

allergies. 

o If patient is marked as having no known allergies, and the user adds a new allergy, the system will 

automatically remove the no allergy phrase. 

 

 No Known Problem in diagnosis – users can now click a button in the Visit Note>Patient Diagnosis 

window, to mark a patient as having no known problem. 

o In the Visit Note screen click Diagnosis in the left-side panel. 

*item could be named differently based on the settings in Setup>Visit Note>Options (Left Frame). 

o The new button is located in the bottom left of the window. 

o Click this button to mark that the patient has no known problem. 

 If any active diagnoses are listed, the system will prompt the user with: 
 

 
 

 User can choose to Cancel the action… or click the option to inactivate all current 

diagnoses. 

o If patient is marked as having no known problem, and the user adds a new diagnosis, the system will 

automatically remove the no known problem phrase. 

 

 Document option as separate window – users now have the option of being able to view the patient’s 

documents in a separate program window while in the Visit Note screen. 

o Set related parameter to “Yes”: 

Setup>User Parameters>Visit Note>Allow to work with visit note while viewing document 

o In the “Visit Note” screen, click the Document option in the right-side panel. 
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o A separate program window opens displaying the first of the patient’s documents. 

 Use the drop down list in the top left corner of the screen to select a particular document to 

view. 

 Use the left/right arrows  at the top of the screen to navigate back and forth through 

the documents in the list. 

 Walley icon is available at the top of the screen to access a menu of standard options. 

 User can also Print, Fax or utilize the Quick Info button as in the regular Document screen. 

o User can switch back and forth between Visit Note and this screen without having to close either. 

o This screen can be minimized, and will show as a separate program in the Windows task bar. 

o If this screen is open and the user clicks any template questions on the left-side panel, or any of the 

items in the right-side panel, the document screen will be temporarily hidden until the user closes out 

of the selected item. 

 

 De-selecting Template Questions - User will get a warning if deselecting a template question that has more 

than one item selected in its sub level(s). 

o New user parameter added.  This should be set to “Yes.” 

 Setup>User Parameters>Visit Note>Prompt if more than one sub level options are selected. 

o When the Positive box is clicked again, to deselect an item, the user will receive a warning if more 

than one item is selected in the following sub level… or if items are selected in more than one sub 

level. 

 
 

o This can be especially useful in cases where the user has selected several items in the sub levels, and 

then accidently clicks the Positive box instead of the item name, which will deselect that question 

and all sub level items. 

 

 “Visit Note Image” screen changes. 

o Activities>Visit Note>click Image in right-side panel 

o Display Scale:  user can adjust the width and height of the image. 

 Width – enter % of current width to adjust size of image. 

 Height – enter % of current height to adjust size of image. 

o The “Note” field has been removed and replace with the “Note” icon . 

o  “Select from Patient Album” icon  added. 

 This icon will only show if the related system parameter is set to “Yes.”  

 Setup>System Parameters>Modules/Features>“Allow Patient Photo Management” 
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 Entry Log feature added to record entries made in the visit note by date and user. 

o Entry Log menu item added to the Option menu in the right-side panel of “Visit Note” screen. 

o Window lists all data entries made in the visit note.  For each entry system will show: 

 Description 

 Created By 

 Created Date/Time 

o Type – use this drop down to limit the entries shown to just one particular section. 

o Created By – use this drop down to limit the entries shown to just those created by a particular user. 

o  Free text data entry using “Add/Edit Note” will not be recorded in this window. 

o Visit Note Image and Visit Note Forms usage will not be recorded in this window. 

o If Vital Signs are entered more than once in the same visit, only the first time will be recorded in this 

window.  

 

 Status History – feature added to record visit note status changes. 

o “Visit Note” screen>Options in right-side panel>Status History. 

 “Status History” window will open and display all status changes that have occurred for this 

note.  For each entry, system will show: 

 From Status – status of visit note prior to this change. 

 To Status – status of visit note after this change. 

 Changed By – user name of who changed the status. 

 Changed Date – date and time status was changed. 

 User can select a row and click the Delete button to remove a history entry, if needed. 

 

 If more than one visit note for the same patient is created for the same date, users can prevent prescriptions 

that are created in one of the visit notes from showing up in the other one. 

o New system parameter added:  Setup>System Parameters>Prescription>Show prescribed Rx in the 

visit note if it is selected for this visit. 

 When set to “Yes,” only prescriptions created in that particular visit note will be shown. 

Example: Patient sees Provider A and Provider B on the same date.  Prescriptions written by 

  Provider A will not be shown in the “Prescription” section of Provider B’s visit  

  note, and vice versa. 

 When set to “No”, all prescriptions written on a particular date will be shown in every visit 

note for that date. 

Example: Patient sees Provider A and Provider B on the same date.  Any prescriptions  

  written by Provider A will also be listed in the “Prescription” section of Provider  

  B’s visit note, and vice versa. 

 

 New option for when to show pending Visit Notes in Sign off section of “My Tasks” screen. 

o Setup>User Parameter>Visit Note>Show pending signoff visits in my task 

o “If performing provider has signed off” option added to drop down for this parameter. 

 This option will apply in situations where a Visit Note has both Supervising and Performing 

providers.  The Supervising provider must also be marked as the billing provider. 

 The Visit Note will not show up in the “My Tasks” screen of the Supervising provider, until 

at least one of the Performing providers has signed off. 

 

 Translation Box – as the user selects template question data, the translation box will automatically scroll, if 

needed, to display the most recent information populated into the box. 

o The provider will no longer have to manually scroll down to see the information just entered. 
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 Careplan. 

o Setup>Visit Note>Careplan>Import 

 Selection method changed to a standard left click to check/uncheck items. 

 The “Select/Deselect” button has been removed. 

 Selected careplan will now display in HTML format instead of Text format. 

 Careplan is not editable. 

o Visit Note screen>Careplan in left-side panel 

*item could be named differently based on the settings in Setup>Visit Note>Options (Left Frame). 

  the “GoTo” button has been moved from the middle right to the lower left of the screen. 

o Visit Note screen>Print in right-side panel 

 Careplans will now print with HTML formatting, letterhead and images. 

o Check In/Out>Checkout 

 Careplans will now print with HTML formatting, letterhead and images. 

 

 Right-side panel of visit note screen can now be modified in the same way as the left side panel. 

o Setup>Visit Note> 

 Original “Options” section renamed to “Options (Left Frame)” 

 “Options (Right Frame)” section added. 

 Display – the label that will be displayed for the item, in the right-side panel. 

 Group – section of the right-side panel in which the item will be displayed. 

 Show – check the box if the item should be shown in the right-side panel. 

 The “Go To” and “Option” items cannot be hidden. 

 Seq. No. – enter a number to determine in what order the item should be listed. 

 Sequence numbers are particular to each Group. 

 Set by Office, Provider, Procedure & Gender – use this button to create settings 

that are particular to office, provider, procedure and/or gender. 

 This feature does not apply to “Display” names, as they are system wide.  

o “Analysis” section label removed – each item in this section now has an icon. 

 

 Set iSpot feature added for template questions. 

o Setup> Visit Note> open a template component such as ROS. 

o iSpot, a hot spot editor, feature has been added which allows attaching an image to a question and 

plotting hot spots on it that are associated with sub level questions. 

 Select a question in the left panel, and then click the “Set iSpot” option in the middle panel 

of the screen. 
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 If no previous images have been setup for this question, the “Set Image” window opens 

where the user can select the image(s) to attach. 
 

 
 

 User has the ability to set 4 separate images to represent different views for front, 

back, left and right. 

 Multiple sets of images can be added and made specific to patient gender and/or age. 

 Click the Add button to add another set of images. 

 Click the Delete button to remove a set of images. 

 Click the  icon for one of the 4 views, to select an image file. 

 Once the image is selected, the Edit  and Delete  icons will be appear for that 

image. 

 Click Save and then Close. 
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 The “Set iSpots” screen will now display the selected image. 
 

 
 

 Click the Polygon button to draw the area(s) where the user will click on the picture. 

 Do a single mouse click to anchor each side of the drawing area, and then 

double click to join the last sides and complete the area. 

 Click the arrow button on the tool bar to do one of two actions: 

1. Single click and hold on existing hot spot area to select it, then drag it with the 

mouse to move it to a different spot on the picture.   

2. Double click an existing hot spot area to link it to sublevel questions. 

 Only sub levels of the originally selected question will be available. 

 Only one sub level can be selected. 

 When a hotspot area has a sub level selected, it will appear filled with 

a criss-cross pattern. 

 
 Click Save and then Close. 

 Template questions/sub levels that have iSpot images set up will display “(IS)” at the end of 

the question name in the left side panel tree. 

o To use the iSpot image, go to the “Visit Note” screen. 

 Select the appropriate template component from the left panel of the screen and select the 

question for which the iSpot is set. 

Click the Polygon 

button to plot a hot 

spot area. 

Click one of the 4 boxes 

to access that view from 

this image set. 

Click this icon to 

return to the “Set 

Image” window. 

Click this button to 

move an existing hot 

spot area, or to link 

sub level questions 
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 The “Select iSpot” window will open. 

 Double click the hotspot area to select the linked question and open the associated sub 

level on the screen. 

 The user can switch to the normal view of the question by clicking Show Question in 

the bottom left corner of the screen. 

 Switch back to the Image by clicking Show iSpot at the bottom of the question list. 
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10. Prescriptions 
 Dose Form (Drug Unit) section added in “Misc. Values” window. 

o Setup>Other>Misc. Values 

o Dose Form (Drug Unit) section added. 

 Items in this list will populate the drug Dose Form and Unit fields anywhere in the system 

that a medication is prescribed or medication details are selected. 

 The fields were previously populated by hard coded lists that could not be added to. 

 Users can modify the list using the Add and/or Delete buttons. 

 

 Duplicate Rx – system will now flag any Rx as a “Duplicate” after it has been printed/faxed the first time. 

o Utilities>Patient>Prescription window – “DP” column added to far right.  Displays a checkbox for 

each item row. 

 When the Rx is printed/faxed the first time, system will automatically check this box, to 

indicate that any subsequent print/fax will be a duplicate. 

 Checkbox can checked/un-checked manually, if needed. 

 Duplicate box is automatically set back to un-checked, when a refill is approved, until the 

refill is printed/faxed for the first time. 

o Visit Note>Prescription – In the Show Detail (click Show Detail button) view, “Duplicate” 

checkbox added to each item row. 

 When the Rx is printed/faxed the first time, system will automatically check this box, to 

indicate that any subsequent print/fax will be a duplicate. 

 Checkbox can checked/un-checked manually, if needed. 

 Duplicate box is automatically set back to un-checked, when a refill is approved, until the 

refill is printed/faxed for the first time. 

o Prescription Layout – 5 new fields added to be used to indicate when printing a duplicate Rx. 

 Setup>Prescription>Print Layout 

 5 new fields in Database Field List: 

 Rx:  Duplicate (1) 

 Rx:  Duplicate (2) 

 Rx:  Duplicate (3) 

 Rx:  Duplicate (4) 

 Rx:  Duplicate (5) 

 Rx Duplicate field(s) will print Y or N, to show if Rx item is a duplicate.  

*Be sure to include a label when using this field(s) in the layout, since the actual text 

generated does not include “Duplicate”  

 Rx Duplicate field(s) must be present on the layout in order for the printed Rx to show as a 

duplicate.  If Rx is marked as a duplicate in the system, but the fields have not been added to 

the layout, nothing will show on the actual print out to indicate the duplicate Rx. 
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 Rx Layout – added the ability to have multiple Rx layouts based on Controlled/Non-Controlled drugs. 

o Setup>Prescription>Print Layout 

o Added Edit icon   to the right of the Select drop down field, to allow user to edit the settings of 

the layout currently selected. 

 

 
 

 Controlled/Non Controlled section added: 

 All – check this box if this layout should be used for all controlled and non-controlled 

drug prescriptions. 

 Non controlled – check this box if this layout should only be used for non-controlled 

drug prescriptions. 

 Controlled – check the box next to each schedule drug type that this layout should be 

used for.  Multiple types can be selected. 

o When printing/faxing multiple prescriptions at the same time, the system will apply the appropriate 

print layout for each medication according to the criteria set.   

 Any medications that share the same criteria will be printed on the same script layout. 

 

  “Approve/Deny Refill” – added a Note field to this window. 

o In “Visit Note” screen, click Prescription in the left-side panel. 

 Select the medication and click the Approve Refill button at the bottom of the window. 

 User can enter free text comments in the Note field. 

o This field can be added to the prescription layout. 

 Setup>Prescription>Print Layout>Field List 

 Rx: Last Appr/Denied Note (1) 

 Rx: Last Appr/Denied Note (2) 

 Rx: Last Appr/Denied Note (3) 

 Rx: Last Appr/Denied Note (4) 

 Rx: Last Appr/Denied Note (5)  

o This Note will also be displayed when the user edits the prescription, in the “Last Approved/Denied 

Refill” section of the “Edit Prescription” screen. 

 Mouse over the “Note” field label to display tooltip “Click to View Full Note” 

 If clicked, the complete text will be displayed in a message popup. 
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o Note can also be viewed from the “Prescription Refill History” window. 

 In the main “Prescription” window, click the History button and select “Refill History.” 

 An  icon will be shown at the beginning of the Entered By column, for any 

prescription that has had an approve/deny note entered. 

 Clicking the icon will display the note text in a message popup. 

 Only the last approve/deny note entered for this prescription will be shown. 

 

 Supervising Provider fields added for use in prescription layout. 

o Setup>Prescription>Print Layout 

o 7 new Supervising Provider fields added to the Database Field List in the right panel. 

 Rx: Supv. Pr. Credential 

 Rx: Supv. Pr. DEA 

 Rx: Supv. Pr. Firstname 

 Rx: Supv. Pr. Lastname 

 Rx: Supv. Pr. NPI 

 Rx: Supv. Pr. SLN 

 Rx: Supv. Pr. UPIN 

o There are 5 instances of each field available. 

 

 Prescribed by Other MD – entries for prescriptions given by external providers are more accurately/visibly 

labeled. 

o “Prescription” screen…“Prescribe” section… when user selects “Other MD” in the “By” field, the 

system will show  in the “Provider” and “By” fields. 

 

11. Lab/Diagnostic Results 
 Office filter added to Lab Tracking screen. 

o Click Diagnostic/Lab Order button on main IMS toolbar… or Activities>Diagnostic/Lab Order. 

 Office filter added to the top panel of the screen (before Diagnostic/Lab filter). 

 Office column added to the information columns in the main panel of the screen (between 

Provider and Order No. columns). 

 

 Page navigation viewing added in lab tracking and my tasks. 

o Change seen in two screens: 

 Click Diagnostic/Lab Order button on main IMS toolbar… or Activities>Diagnostic/Lab 

Order. 

 Right-click an order item that is reviewed/received, and select View Linked 

Document. 

 Click My Tasks button on Main IMS toolbar, then Lab… or Activities>My Tasks>Lab. 

 Use the Status filter to display Reviewed or Received order items, and then click the 

 icon for an item to View Linked Document. 

o After the user opens the linked document view from either of these screens, they can use the  

buttons at the top of the window to navigate to the previous/next result document. 

o The  button can also be clicked to move to the next document. 

o Users can also pick a particular result document to view, from the drop down list in the top left 

corner of the window.  
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 Note field can now allows up to 300 characters. 

o Activities>Diagnostic/Lab Order>click Order Lab icon in right side panel. 

 In the lower right panel, the Note field for a selected test will now allow up to 300 characters. 

 The full Note text will be displayed in the Note column in the main “Diagnostic/Lab Order” 

screen. 

o Also applies to orders entered via: 

 Activities>Visit Note>click Diagnostic/Lab in left-side panel. 

 The entire text entered into the Note field will also appear in the Visit Note middle 

panel, below the name of the test ordered.  

 

 Status set as “Not Done” for Preliminary result when the Final result is received. 

o Pertains to received HL-7 results. 

o Seen in My Tasks>Document, if system parameter is set to show HL-7 documents here. 

*Setup>System Parameters>Other>“Show HL7 Lab Reports in My Task->Documents” 

 If a preliminary result report was received previously, and marked “Done” when the same 

result report is received again as a Final result, the system will automatically change the 

status of result back to “Not Done.” 

 

 Users can now Decline HL7 results that should not be imported into a patient’s file. 

(ex.  results for a hospital patient that is not seen in the office) 

o Activities>Diagnostic/Lab Order screen>HL7:  Receive 

 Right-click the appropriate HL7 entry and click Decline. 

 Entry will be removed from the list and the actual HL7 file will be moved to 

C:/IMS/Lab_Documents/hl7rec/Decline. 

 The “Decline” folder will be created automatically the first time an HL7 

import file is declined. 

 

 Patient matching for HL7 imported results. 

o Activities>Diagnostic/Lab Order screen>HL7:  Receive 

o When lab results are being imported, the system matches the patient by last name, first name, SSN, 

DOB, and gender. 

 SSN can now be matched with or without the hyphen (-) present in the result file. 

 If Chart No/DOB/SSN are not provided in the result file, the system will not show an error, it 

will only show an error if these are provided but do not match.    

o If there are two or more mismatches with the patient information, the system will display the 

mismatches in the Import Status column. 

o User will be given the opportunity to manually link the result to a patient in the database. 
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 Client Account# will be shown in HL7 Lab Result Report 

o Activities>Diagnostic/Lab Order>click Receive in right-side panel. 

 Receive and import results into IMS. 

o In the main “Diagnostic/Lab Order” screen, right-click on an imported result, and then select View 

Linked Document. 

 Client Account No. should appear under the “Client Info” section. 

 Depending on the original ordering circumstances, the Client Account No. will be the 

account # of the: 

 Ordering Provider 

 Ordering Office 

 Ordering Group 

 Ordering Physician 

 Logged in User’s Default Office. 

 

 HL7 results – change the way result message is handled if there are both “Ordering” and “Copy To” 

providers included in result message data. 

o If the “Ordering” provider is an IMS provider, the result will be sent to the My Tasks>Lab of that 

provider only. 

o If the “Ordering” provider is not an IMS provider, but the “Copy To” provider is, then the result 

will be sent to the My Tasks>Lab of the “Copy To” provider. 

o If neither the “Ordering” nor “Copy To” providers are IMS providers, the result will be sent to the 

My Tasks>Lab of the System User. 

 

12. Immunizations 
 2 new fields are available when recording an immunization. 

o “Patient Master” screen>Immun. icon in right-side panel>“Patient Immunization” window. 

“Visit Note” screen>Immunization in left-side panel>“Immunization” window>Add. 

o Two new fields: 

 Route – method by which the immunization was given, such as oral, nasal, etc. 

 The drop down list will be blank initially, users can type in a new item and press Tab, 

and the system will prompt to save the item to the list. 

 Administered Note – text field to enter any comments related to the administration of the 

immunization. 

o Fields have been rearranged on the windows to accommodate the new fields. 

 

 Given button added to the “Immunization” window. 

o “Visit Note” screen>Immunization in left-side panel>“Immunization” window 

o Click the Given button at the bottom to open the “Given Immunization” window, which will list all 

ordered immunizations for this visit.  

 The user can then enter the information for each immunization given, all in the same 

window, without having to edit each immunization, one at a time. 

 

13. Letter Templates 
 Improved speed of letter generation.  This change affects the following areas: 

o Visit Note>Letter 

o Visit Note>Print/Fax/Email>Letter 

o Schedule>Letter 

o Schedule>Multiple Letter 
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 Added Checkout Receipt section to Field List for “Billing” type letter templates. 

o For use with new Checkout Receipt letter function (see Billing>Posting Payments, in this document) 

 

 Added Patient Statement as new letter Type. 

o For use with new function of generating patient statements by letter template. 

o Field List contains three groups of database fields for use in the letter template. 

 Patient Custom Fields 

 Patient Statement 

 Patient Statement Aging 

 

 Select from Template – ability to select more than one item without closing the window, when using the 

“Select from Template” or “Select from Template (Positive)” options. 

o Setup>Other>Letter Templates 

o Letter Templates with “Type” = Visit Note. 

o Field List>Visit Note>Select from Template… or Select from Template (Positive) 

o In the “Select From…” window: 

 User can double click an item, or select an item and click the “Select” button, to insert the 

item into the letter template. 

 The window will stay open so that the user can then select another item, if needed. 

 After all needed items have been selected and inserted, click the “Close” button to close the 

window. 

 

 Field List for Schedule, Visit Note, and Reminder/Note type letters. 

o 3 new fields added under the Patient Diagnosis section. 

 Description only (Other M.D.) 

 ICD & Description (Other M.D.) 

 ICD only (Other M.D.) 

 

 List Columns – Next Line option added to “Conjunction” drop down. 

o Setup>Other>Letter Templates>F7 (List Columns) 

o “Conjunction” drop down list on the right side of window has new option:  

 Next Line – When the letter is generated for a patient, the system will list each of the user’s 

choices vertically, on a separate line, instead of listing them left to right on the same line. 

 

 New fields from “Referring Provider” screen are available for use in Letter Templates. 

 Field List>Referred By>Ref. By Dr. Practice Name 

 Field List>Referred By>Ref. By Dr. Practice Contact 

 

 Type drop down list. 

o “SMS/IVR” changed to “SMS” 

 Field List groups have been changed: 

 Visit Note 

 List Columns (System) 

 Patient Custom Fields 

 SMS 

 Sp. Columns (System) 
 

 WCAB No – this field from the Case details will now be available for use in the Letter Templates. 

o Setup>Other>Letter Template>Field List (on right panel)>Case>WCAB No 
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14. Forms (To be filled) 
 Added a Fax button so users can fax as well as print from Fill Form screen. 

o Check In/Out (F10) screen>“Check In” window>Forms to be Filled 

 

 “Copy Form” window will now pop up when user clicks the “Add and copy this form” link. 

o Setup>Other>Forms to be Filled 

o This window allows the user to change basic settings for the new form prior to creating it: 

 Description 

 Will default to the name of the original form with “-copy” at the end.  User can 

manually change, if needed. 

 Cannot be named exactly the same as another form. 

 Office 

 Provider 

 Procedure 

 Room 

 Insurance 

 

 New fields from “Referring Provider” screen are available for use in forms. 

 Field List>Referred By>Ref. By Dr. Practice Name 

 Field List>Referred By>Ref. By Dr. Practice Contact 

 

 WCAB No – this field from the Case details will now be available for use in the Forms (To be filled). 

o Setup>Other>Forms (To be filled)>Set Column>Case>WCAB No 

 

15. Multi Scan/Select Documents 
 Added the “Click here to select file” link at the bottom of the left-side panel. 

o Click this link to browse to, and select, any file on a network or local drive. 

o There is no limitation on file extensions that can be selected.  

 

 Scan on Citrix Client – option added to specify scan from a Citrix client. 

o Setup>Admin>Computer 

 “S” check box (Scan on Citrix Client) added to each computer row. 

 Check this box to have the From Citrix Client option shown on the “Scan Document” 

popup window. 

o Utilities>Multi Scan/Select Document (or click the button on main IMS toolbar) 

 Click the New Scan button to initiate scanning a document, and the “Scan Document” 

window will pop up. 

 The From Citrix Client checkbox will show in the bottom right of the window. 

 When this box is checked and the client performs a duplex scan, each page 

will be scanned in as a separate JPG file.  After the last page is scanned, the 

system will automatically merge the JPG files into one TIF file. 

*after the TIF file is created the individual JPG files are deleted. 

o This feature is intended to prevent system slowdown when scanning large files over a Citrix client.  

o This will apply to scanning from anywhere in IMS where the “Scan Document” popup window 

appears. 
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 Link to Authorization 

o Multi Scan/Select Documents screen - if a category is selected that is an “Authorization” type, a 

“Link To” option will appear beneath the Patient field, after the patient is selected. 
 

 
 

 Click this option to open the “Link To Authorization” window. 

 Check the box for each authorization this document should be linked to. 

 Click Ok. 

 

16. Fax 
 Fax Cover Page – made more database fields available to be used on fax cover page. 

o Setup>Admin>Fax Cover Page>Set Columns 

 Two additional groups of database fields have been made available: 

 Patient 

 Patient Insurance (Primary) 

 

 Default Fax Coverpage – users can now set a user specific default fax cover page, so that they do not have 

to select a cover page every time they send a fax. 

o Setup>User Parameters>Reminder & Fax>Default Fax Coverpage. 

 The cover page selected here will be used whenever this user initiates a fax. 

 User can select a different cover page on the fly, if needed.  

o Removed “Default” checkbox in Setup>Admin>Fax Cover Page 

 If a cover page has been marked as “default” prior to v14, it will be set to the above 

parameter for each user when system is upgraded to v14. This can then be changed by the 

individual users. 

 

 Fax Received - Added Forwarded By information column for received faxes, to show the user that 

forwarded the fax (if any). 

o Added to the Fax Received and My Tasks screens. 

 Fax Received – column is found in upper left-side panel, where fax items are listed, right 

after the “Forward To” column. 

 My Tasks>Fax – when a fax item is highlighted, the column is found in the right-side panel, 

after the “Forward To” column. 

 

 Forwarded History option added. 

o Click Fax Received button on main IMS toolbar… or Utilities>Fax>Received. 

 Right-click the appropriate fax item in the upper left panel, and select Forwarded History. 

 “Forwarded History” window opens and displays a list of all users to whom this fax 

has been forwarded. 

 If fax/document has never been forwarded the system will display a popup message 

stating “Document forwarded history does not exist” 
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o This option is also accessible from other screens: 

 Patient Documents [Utilities>Patient>Document] 

 Right-click on document> Forwarded History 

 Patient Documents [Activities>Document] 

 Select document on left 

 Click Go To Detail button 

  “Click here to view document forwarded history” link added in “Forward 

To/Respond” section. 

 Chart View [Utilities>Patient>Chart View] 

 Document tab 

 Right-click on document>Forwarded History 

 My Tasks [Activities>My Tasks] 

 Fax and Document sections 

 Right-click item>Forwarded History 

 

 Fax Received - Link to selected authorization 

o Fax Received screen – if fax item has a category that is an “Authorization” type, and user clicks the 

Autho. Button: 

 Link to selected authorization checkbox will be shown in the bottom left corner of the 

“Authorization Tracking” overlay window. 

 If this box is checked, the fax item will be linked to any selected authorizations, when 

the user clicks Save. 

 
 

 Same process can be used from My Tasks>Fax>View 

 

 Send Fax – Facility field, in the send to section, will now auto populate from the “Patient Master” screen if 

the patient has a Facility selected there. 

o Applies to: 

 In “Visit Note” screen, click Fax in the right-side panel. 

 “Patient Document(s)” screen accessed from most anywhere, click the Fax button. 

 Except clicking the Document button on the main IMS toolbar… cannot fax from this 

screen. 

 

 Sensitivity – the row background colors associated with each sensitivity setting will now be shown in other 

fax screens the same as it is in the “Patient Documents” screen. 

o Affects two screens: 

 Fax Received 

 My Tasks>Fax 

o Sensitivity settings: 

 Normal – light blue row color 

 Moderate – orange row color 

 Urgent – red row color 
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 Purge Faxes – added the ability to purge deleted faxes permanently from the system. 

o Purge Faxes button  added to “Deleted Fax” screen. 

 Fax Received screen>View Deleted button. 

 Button added at the bottom, beside the Reactivate button. 

 Button will only be visible to users who have Fax Admin rights, the Admin group, or the 

System user. 

 The system will maintain an audit log for those faxes purged. 

 Purged faxes will also be removed from Patient Documents for the associated patient, if any. 

o System now allows the View Deleted button to open the “Deleted Faxes” screen, even if there are no 

faxes listed in the “Fax Received” screen. 

o Columns changed on “Deleted Faxes” screen, which now contains the following columns: 

 Deleted Date 

 Deleted By 

 Delete Reason 

 Receive Date 

 Received From 

 For 

 Category 

 Status 

 Forward To 

 Company 

 

17. Reminders 
 Separate Print and Fax buttons added to replace the Letter button in Reminder, My Task>Reminder, and 

Health Maintenance screens. 

o Reminders>List View 

o Health Maintenance>left side panel 

o These buttons will now function the same as in the Authorization Tracking screen and other tracking 

screens. 

 When only one item is selected, the actual “Patient Letter” window will open. 

 When multiple items are selected the “Select Letter Template” window will open. 

 The Print Label checkbox is now available on this screen. 

 

 Refill Request option added. 

o Activities>Reminder>Add 

o Link To drop down list now contains the “Refill Request” option. 

 When “Refill Request” is selected the  icon will appear beside the field. 

 Click the icon to open the “Select Prescription” popup window, where the user can 

select one or more of the patient’s active medications. 

 Once a medication is selected, the icon will change to . 

 Details for the selected medications will appear in the Note field. 

o Activities>Reminder>List view 

 The refill request reminder will an  icon at the end of the Task column. 

 Click this icon to open the patient’s Prescription window, and process the refill. 

 The medication(s) associated with the refill request reminder will have a   

icon at the end of the line. 

o Activities>My Task>Reminder 

 Same as in Activities>Reminder>List view. 
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 SMS related changes. 

o Activities>Reminder> Setup  

 Task tab 

  changed to , and now brings up slightly changed “SMS” window. 
 

 
 

 SMS icon turns green  when setup for a task. 

o Activities>Reminder>Add 

  changed to , and now brings up slightly changed “SMS” window, as seen 

above. 

 When this window is opened while adding a reminder for a patient, it will also display the 

patient’s cell phone number and carrier in the title bar, if either has been entered in Patient 

Master. 

 

18. Posting Charges 
 The same CPT code can be entered more than once for the same Service Date. 

o When entering a CPT charge line, if the user enters the same CPT code again for the same service 

date, the system will display a warning message: 
 

 
 

o Will be seen in: 

 Charge Posting [F6] [Billing>Charge Posting] 

 Charge Posting (Multi) [Billing>Charge Posting (Multi] 

 Quick Bill [Billing>Quick Bill] 

 Superbill [Visit Note>Superbill] [CI/CO>Superbill] 

o CAUTION:  if user clicks “Yes” on warning and then does NOT enter an appropriate modifier for 

the second instance of the CPT, the system will not prevent the charges from being saved. 

 

 Auto-populate newly created authorization number into Autho. No. field. 

o Charge Posting (F6)>click Autho. button at bottom of screen. 

 In “Authorization” popup window, enter information for a new authorization. 

 Click Save and then Close. 

o The authorization number just created will now appear in the Autho. No. field. 
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 Two new fields added to the “CPT Detail” window. 

o Go to CPT Detail window. 

 Billing>Charge Posting> click the  icon at the end of the charge line. 

 Billing>Charge Posting (Multi)> click the  icon at the end of the charge line. 

o Two new fields added in conjunction to NDC Code field. 

 Strength 

 Strength Value 

o Fields will only be active if NDC Code is selected. 

o Information from these three fields (NDC Code, Strength, Strength Value) will be printed in box 24a 

on the HCFA form. 

 

 System will now allow up to 8 ICD (diagnosis) codes. 

o Anything labeled “ICD-9” in system has been changed to “ICD” to accommodate for use of ICD-10 

codes as well. 

o Wherever users could previously select 4 diagnoses for billing purposes, 4 additional diagnosis fields 

are now available: 

 Superbill [Visit Note>Superbill icon in right-side panel] – click the down arrow  to the 

right of the 4
th

 diagnosis field, to display the additional ICD fields. 

 Charge Posting (F6) [Billing>Charge Posting] – click the down arrow  to the right of the 

4
th

 diagnosis field, to display the additional ICD fields. 

 The number of Modifier fields has been reduced to 2. 

 If more than two modifiers is needed, click the  icon at the end of the charge line to 

and enter additional modifiers in the “CPT Detail” window. 

 CPT Detail [Billing>Charge Posting or Charge Posting (Multi)] 

 Click the  icon at the end of the charge line to open the “CPT Detail” window. 

 In the ICD section at the top right of window, there are now 8 diagnosis fields. 

 Charge Posting (Multi) [Billing>Charge Posting (Multi)] – when the user clicks in or tabs 

to the Diagnosis field, a pop up window will display containing 8 diagnosis fields. 

o Up to 8 selected diagnoses will be transmitted when filing the claim electronically, however only the 

first 4 will be shown when printing out the claim on paper. 

 

 Capped Amount – user can now set a capped amount in Case Insurance, so that if charges related to that 

case are entered and exceed that amount, the user will see a warning message. 

o Click Case button on main IMS toolbar… or Activities>Case. 

o Click the Insurance icon in the right-side panel. 

o Three new fields added:   

 Capped Amount:  enter the maximum $ amount of total charges that can be entered for this 

case insurance. 

 Billed:  total of all entered charge amounts that are associated to this case insurance. 

 Bal (balance):  (Capped Amount – Billed amount) amount remaining until capped amount is 

reached. 
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o If capped amount is exceeded while entering charges, the user will see a warning message: 
 

 
 

 Warning message will be displayed after clicking the Save button. 

o This new feature is seen in: 

 Charge Posting (F6) (Billing>Charge Posting) 

 Pertains to charges entered directly, as well as those brought in from a superbill via 

“To Be Billed.” 

 Charge Posting (Multi) [Billing>Charge Posting (Multi)] 

 

19. Claims 
 All items labeled “HCFA” have been changed to “CMS1500” throughout the system. 

 Show/Print Claim Form Background Image – option added to view and/or print the actual form image when 

printing claims. 

o Setup>System Parameters>Insurance Claim>“CMS 1500/UB04 Background Image” 

 Show – will show the form image in the preview, but will not print it. 

 Dont Show – will not show or print form image. 

 Show and Print – will show form image in preview, and will print it on actual printout. 

o If parameter is set to either Show or Show and Print, two additional parameters must be set. 

 Setup>System Parameters>Insurance Claim>“CMS 1500 Form Image” 

 Setup>System Parameters>Insurance Claim>“UB04 Form Image” 

 Click the  icon beside the parameter to select the appropriate image file (ex: HCFA.bmp) 

o The default setting for this parameter is “Dont Show” 

 

 Data from NDC Code, Strength, Strength Value fields will be printed in box 24a on the HCFA form. 

o Two new fields added to the “CPT Detail” window. 

o Go to CPT Detail window. 

 Billing>Charge Posting> click the  icon at the end of the charge line. 

 Billing>Charge Posting (Multi)> click the  icon at the end of the charge line. 

o Two new fields added in conjunction to NDC Code field. 

 Strength 

 Strength Value 

o Fields will only be active if NDC Code is selected. 

 

 Added option to send unique claim number to clearing house. 

o Setup>System Parameters>Insurance Claim>“Send Claim Number for EMC claim(s)” 

 Patient Chart No – system will send that patient’s chart number. 

 Patient Chart No and ENSID – system will send patient’s chart number and ENS ID.  

 Unique Claim ID – system will send a unique claim id (Batch ID + CLM loop counter). 

 If this option is selected, two additional parameters are made active: 

 “Prompt for select claim(s) while posting insurance payment by Claim No” 

o Yes – system will pop up a claims selection window when posting 

insurance payments. 
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o No – system will automatically load all claims sent in the same claim 

loop as the claim id specified. 

o The default setting for this parameter is “Patient Chart No” 

 

 Mark Claim as Sent – added parameter to control when claims are marked as “Sent.” 

o Setup>System Parameters>Insurance Claim>Mark Claim as Sent 

 On Preview – claim will be marked “Sent” if the claim is previewed in the print form screen, 

even if the Print button is not clicked to actually print the form. 

 On Print – claim will be marked “Sent” only if the Print button is clicked in the print 

preview window. 

 On Print after Confirmation – claim will be marked “Sent” after clicking the Print button, 

only if the user clicks “Yes” on the system prompt to confirm that the form printed 

successfully. 

 

 Pre-Claim Test window – now able to put a claim(s) on hold from this window. 

o Billing>Claims>Pre-Claim icon in right-side panel 

o Added a Hold button  at the end of each row (beside Fix Error button). 

o Click this button to hold a claim which has errors that cannot be fixed immediately. 

o When the Hold button is clicked the “Claim(s) to be Sent” window opens and will list other claims, 

from this pre-claim test, that have the same error as the one originally selected for hold. 

o The user then has the opportunity to select one, or more, of the listed claims, and then click the Hold 

button to place them on hold at the same time. 

 The “Hold Note” window will pop up and require the user to enter a reason for putting the 

claim(s) on hold. 

 

20. Patient Statements 
 “Statement Criteria” window contains new options. 

o Billing>Patient Statements>select one of the 4 standard formats. 

 Date Range checkbox – click this to use a From/To date range filter, based on Date of 

Service, instead of “As On” date. 

 Case Type - drop down selection to filter by a particular case type.  

 

 System Parameter added for UB, to print CPT on statements instead of Revenue Code. 

o Setup>System Parameters>UB>“Display CPT(s) instead of Revenue Code on Patient Statement” 

 Yes – comma separated CPTs will be displayed on patient statement instead of revenue code.   

 If there are multiple CPTs listed, the CPT descriptions will not be included. 

 If there is only one CPT associated with the revenue code, the CPT description is also 

displayed. 

 No – Revenue Code is displayed with its description. 

 

 Statement History – screen changes. 

o Billing>Patient Statements>Statement History 

o 4 new information columns added: 

 Case Type 

 From Date 

 To Date 

 Office List 

o Order of columns has been changed. 

o View icon  added in “V” column for statements generated using standard Formats 1-4. 

 Statement can be printed from the view window. 
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 Patient Statements by Letter Template – users can now generate patient statements using a letter template(s), 

instead of the 4 standard formats. 

o Patient Statement (New) option added to menu Billing>Patient Statements. 

 

 
 

o A new “Patient Statement” screen opens: 

 

 
 

 Top panel contains all of the same filters that are available in the standard “Statement 

Criteria” window. 

 Two additional options have also been added: 

 Office Address (Charges of same Office) – select which address should be used as 

the return to address, when all charges on the statement are from the same office. 

 Address of Logged in User’s Default Office 

 Address of Service Office 
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 Address of Patient Office 

 Address of Office Group 
 Office Address (Charges of different Offices) - select which address should be used 

as the return to address, when charges on the statement are from different offices. 

 Address of Logged in User’s Default Office 

 Address of First Service Line Office 

 Address of Patient Office 

 Address of First Service Line Office Group 
 Default selections for these two fields can be set in Setup>System Parameters>Bill 

General: 

 “Office Address to be printed on Patient Statement (New) When Charges are 

of Same Office” 

 “Office Address to be printed on Patient Statement (New) When Charges are 

of different Offices” 

 After selecting the appropriate filters, click the  button to retrieve all matching patient 

statements into the bottom panel. 

 Check the box for each statement needed. 

 Click the Print button to bring up the “Select Letter Template” window. 

 Select a letter template (will only show “Patient Statement” type letters) 

 User is also able to select standard Formats 1-4, in this window. 

 Check the Print Label for mailing labels, if needed. 

 Click the Print button to generate the patient statement letters. 

 User can also choose to Upload on Portal. 

 Upload on Portal – letter selection window will display to allow user to select which 

letter template/standard format to upload. 

 User can also Export the statements. 

 Statements can be exported as:  XML, Bill Flash. 

 Default templates for each export type are stored in c:\IMS\template_documents\ and 

are added/managed by Support. 

 Use the Print List button to generate a printout of the statements currently listed. 

 Double-click any row to open/view that patient statement. 

 The “Select Letter Template” window will open and allow the user to choose a format 

in which to view the statement. 

 Click the View button. 

o A default letter template for the Patient Statement (New) feature can be selected in system 

parameters: 

 Setup>System Parameters>Bill General>“Default Patient Statement format (New)” 

 Drop down list will contain all “Patient Statement” type letter templates and the 4 

standard formats. 

o New “Patient Statement” type added to letter templates. 

 Setup>Other>Letter Template 

 “Patient Statement” option added to Type drop down list in upper left corner. 

 Available field list groups include: 

 Patient Custom Fields 

 Patient Statement 

 Patient Statement Aging 

 Special Columns 

o Patient Statements created using this new feature will still be accessible in the “Statement History” 

screen. 
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21. Posting Payments 
  “Open Credit” window button changes. 

o Billing>Patient Payment Posting 

o Select Patient, and then click  icon to create a new payment record. 

o The “Open Credit” window will open automatically. 

 Ok and Cancel buttons in lower right corner have been changed to Edit and Add. 

 Edit – will load the selected open credit entry into the “Patient Payment Posting” 

screen in order for the user to make changes or apply to charges. 

 Add – will close this screen and return to the Patient Payment Posting screen in order 

for the user to add a new payment. 

o Change was made to help avoid issue of inadvertently overwriting existing open credit entries, if the 

user accidently clicked Ok instead of Cancel, when wanting to add a new payment. 

o The same change is seen when the “Open Credit” window is opened from the “Charge Posting” 

screen, when user chooses to reconcile open credit. 

 

 Calculate Co-pay from allowed amount. 

o Affects patient’s with Insurance that has Copay Type = “Percentage” 

 “Patient Master” screen>click Insurance icon in right-side panel. 

o When co-pay is calculated, the percentage will be based on the CPT(s) allowed amount. 

 

 Checkout Receipt – added the ability to use a letter template. 

o Setup>System Parameters>Payment Posting>Default Letter Template for Checkout Receipt 

 Select the appropriate letter template to use as the default. 

 Drop down list will only list letter templates that are Type = Billing. 

 “Checkout Receipt” section added to Field List for “Billing” letter templates. 

o When in “Checkout Receipt” window, either by clicking the Print button manually or if prompted to 

print a checkout receipt, system will print the receipt using the letter template specified in the related 

system parameter (above). 

o Will function when recording a payment via any of these screens: 

 Billing>Checkout Receipt 

 Check In/Out 

 Patient Payment Posting 

 Charge Posting  

 

 Insurance Payment Posting (F8) – ability to select the same claim line more than once. 

o Click Insurance Payment Posting button on main IMS toolbar… or Billing>Insurance Payment 

Posting 

o After entering payment information for one EOB/claim line, press F11 to add a new row. 

o Enter the same patient and then select the same claim line again from the Pending Bills window. 

o System will prompt the user to confirm that this should be done: 

(previously the system would not allow user to select the same claim again) 
 

 
 

o User can select the claim line as many times as needed, and continue with posting the payments. 
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 Integration of Topaz signature pad for use with credit card payments. 

o First, the credit card feature must be turned on in system parameters: 

 Setup>System Parameters>Payment Posting>“Enable Credit Card Feature” = “Yes” 

o Turn on option to use signature pad. 

 Setup>Admin>Credit Card Parameters 

 Use Sigpad checkbox added – check this box to indicate that the signature pad will 

be used. 

o Add computer specific setting. 

 Setup>Admin>Computer 

 If not already present, add a line for the computer name of the machine that will be 

using the signature pad. 

 In the SignPad column select “1X5” from the drop down list. 

o When a credit card transaction is successful and the Sigpad option is checked, the system will pop up 

the “Signature Pad” window. 
 

 
 

 The patient has to sign and press OK on the signature pad. 

 If the patient presses Clear, the system will allow them to re-sign. 

 If the patient does not want to sign, then the IMS user can click the Cancel button on the 

“Signature Pad” window. 

o This integration feature is only for use with Topaz model no T-LBK460 HSB type (1 X 5). 

 

22. ERA/Auto Reconciliation 
 Payer name is now visible in the “Select ERA Batch” window and the “Auto Reconciliation” screen. 

o “Select ERA Batch” window – Insurance Name column added. 

o “Auto Reconciliation” screen – payer name displayed in orange area to the right of the Select Batch 

button.  

 

 Reverse payments from an ERA can now be processed via auto reconciliations. 

o When ERA containing reverse payment is applied the system should: 

 Identify the correct service line associated with the reverse payment. 

 Reverse the payment by creating a negative entry in the system. 

 Adjust the balance for the responsible party. 
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 Auto Reconciliation – Allowed column added. 

o Billing>Auto Reconciliation 

o Allowed column added (after the Charge column) to display the allowed amount. 

 If the payment amount (i.e. Paid+ Co. Ins. +Pt. Resp.) is less than the allowed amount, the 

system displays the column in red. 

 This will also be displayed at the bottom of the screen as a Note. 

o System Parameter added to specify where to pull allowed amount from. 

 Setup>System Parameters>Payment Posting>”Take allowed amount from Fee Schedule” 

 Yes - the allowed amount is pulled from the Fee Schedule. 

 If no Fee Schedule has been set up then the allowed amount for this CPT 

code, if any, is pulled from “CPT Master.” 

 No - the allowed amount is pulled from the incoming ERA.   

 

23. Patient Ledger (Ctrl+F6) 
 $0.00 ERA Payments 

o Zero payments from ERA Reconciliation will now be shown in the “Patient Ledger” screen. 

 

 Collection follow up notes for the insurance can be entered from the patient ledger screen. 

o Right-click>Collection Followup> “Insurance” option added, for appropriate ledger line items. 

 Opens a Followup Note window, where user can enter a note particular to this insurance. 

o This followup note is also visible from the “Collection” screen, where the relevant insurance will 

show a red flag icon next to it. 

(see Collection section in this document for more information) 

 

 Case filter added to Filter Criteria section of screen. 

o   
o Click the icon to select a case associated with the patient. 

o After selecting a case, only patient ledger items associated with that case will be shown. 

 

 User can now set a default selection for the drop down list in the aging table, in lower right corner of Patient 

Ledger. 

o Setup>System Parameters>Bill General>“Default aging by (In Patient Ledger)” 

 Claim Date 

 Service Date 

 First Claim Date 

 

 Collection status color coding displayed in Patient Ledger. 

o In the “Collection” screen, select a collection status for a patient charge line via Right-

click>Collection Status. 

 The whole charge line is filled with the color of the selected status. 

o In the “Patient Ledger” screen, select the same patient.  

o The same color will be shown in the Amount column for the relevant charge line. 
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 Added a “Note” icon . 

o Icon will appear next to any ledger item that has any kind of Note entered on it, such as a Biller 

Note, Hold Note, Claim Note, etc. 

o Mouse over the icon to display a pop up box listing all Note entries. 

 

24. Collection (Ctrl+F9) 
 The label/term “Collection” has been changed to “A/R Activities” throughout the system. 

Example: 

o Billing>A/R Activities 

o Main IMS toolbar  “A/R Activities (Ctrl+F9)” 

 

 Added access to the “Case” screen via right-click menu. 

o In the “Summary” and “Detail” views of this screen, added the Right-click>Patient>Case option. 

o In the “Main Sum.” view, set Grp.By filter to “Patient” then right-click on the patient line and go to 

Patient>Case.  

 

 3 New Filters – three new general filters added to top panel. 

o Ins Priority 

o Rej. Code – can only be seen if More box is checked. 

o Proc. Code – can only be seen if More box is checked. 

 

 Follow Up Note option added in Main Summary view. 

o In Main Summary view, set Grp. By field to “Insurance.” 

o Right-click on an Insurance line and click the Followup (Insurance) option. 

 A followup window will open, where the user can enter the appropriate information and then 

click Save. 

o Once the followup is entered, a red flag icon  will appear next the insurance name.  

 

 Tooltip added to view last collection followup notes. 

o In Detail view – mouse over the patient name to see a callout style tooltip that will display the 

Insurance/Patient/Claim collection followup notes. 

o The number of collections notes for each type will be displayed in parenthesis next to each: 
 

 
 

  Assign – added the ability to assign collection items to one or more users. 

o Assign button  added to bottom of the screen. 

 Button is only enabled in the “Detail” view. 

 Check the box for each collection item to be assigned, and then click the Assign button. 

 Select from the menu that appears: 

 Assign users 

 Unassign users 

 Switch users 

 The window for the option selected will open in a collapsed view. 
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 In the “Assign user(s)” widow, to quickly assign all selected items to the same user(s): 

 Use the Assign To field to select one or more users. 

 Click the Assign users button. 

 Click Close to return to the “Collection” screen. 

 To use the Detail view: 

 Click the Show Detail button 

 All selected collection items will be listed in the lower area. 

 Check/uncheck any items 

 Use the Assign To field to select one or more users. 

 Click the Assign users button. 

 Continue to do this for any other listed items, as needed 

 Click Close to return to the “Collection” screen. 

 

 
 

 
 

 The “Unassign user(s) window looks and works in the same way to unassign users. 

 There will be an Unassign users button. 

 If a user name is selected in the Unassign field, that isn’t actually assigned to any of 

the selected collection items, then there is no effect. 

Detail View 

Collapsed View 
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 The “Switch user(s)” window essentially allows the user to perform the Unassign and 

Assign To actions at the same time, for the selected collection items. 

 The Detail view can be used if the user needs to select/unselect any collection items 

from the group before performing any of the actions. 

 

 
 

o An asterisk will appear next to any collection items that have been assigned. 

 

 
 

o Two associated filters added to the top panel: 

 Show – All, Assigned, Unassigned 

 Assigned To – select one or more users to display only those collection items that have been 

assigned to that user(s). 

o Two new security settings added to control use of this feature.   

Setup>Security: 

 Billing > Collection (Allow to assign claims to users) 

 Billing > Collection (Allow to change Assigned To in search criteria) 
 

25. Non-Billing Reports 
 PQRI/NFQ/Other – previous “Meaningful Use of EMR” report relabeled. 

o Reports>PQRI/NFQ/Other 

 This is the same report screen that was previously available in v12.0.5 under 

Reports>Meaningful Use of EMR. 
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 Referral Doctor List by Specialty report added. 

o Reports>Setup>Ref.Doctor>Referral Doctor List by Specialty 

o Click Open Report 

 Select one or more specialties from the “Select Specialty” popup window. 

 Select All and Deselect All buttons are provided. 

 Report lists all providers with the selected specialties, grouped by specialty. 

 Information displayed for each provider includes: 

 Name 

 Address 

 City, State, Zip 

 Phone 

 Fax 

 Number of referring providers for each specialty will be displayed at the end of the Specialty 

section. 

 Shows total of Active referring providers and Total of all referring providers in that 

specialty. 

 End of report will show total of All Active referring providers and Total of All referring 

Providers. 

o Setup>Security>Grants tab 

 Reports > Setup > Ref.Doctor > Referral Doctor List by Specialty 

 

 Scheduler-By All Options report – added Patient Balance to available columns. 

o Reports>Front Desk, then Scheduler>General>By All Options 

o Click Open Report. 

o “Report Parameters” window opens. 

 Columns tab – Patient Balance added to list of columns. 

 

 Report Builder – Carrier Type field added. 

o Reports>Report Builder 

 For field = “Charge/Bill” or “Claim/Batch Status” 

 Carrier Type has been added as an option on the Field drop down lists. 

 

26. Billing Reports 
 Annual Tax Statement Report added. 

o Report>Billing>Receipt>Annual Tax Statement Report 

 

 Aging Summary By All Options report added. 

o Reports>Billing>Aging>Summary By All Options 

 

 Changes for “Receipt Detail By All Options” report. 

o Reports>Billing>Receipt>Detail By All Options 

 Payment Type added to all 3 tabs:  Parameters, Group/Sort, Columns 

 2 filters added to top of Parameters tab. 

 For – Patient, Insurance, Both 

 Insurance Priority – drop down list to select All, Primary, Secondary, etc. 

 Include Copay Amt. checkbox option added to top of Parameters tab. 
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 Exclude Payment Type option added for “Daily Deposit” report.  

o User can set a system parameter for which payment types to exclude by default, from this report. 

 Setup>System Parameters>Bill General>“Exclude Payment Type” 

 Click icon beside parameter to select each payment type that should be excluded. 

o In Reports>Billing>Daily Activity>Daily Deposit 

 Payment Types filter added to top of report parameters window. 

 Click icon beside filter to select/de-select payment types. 

 Types that have been excluded using the system parameter will default to being un-

selected. 

 User can manually select an excluded type, if it should be included on the report.  

 

 Insurance Priority filter added to “Aging Detail By All Options” report. 

o Reports>Billing>Aging>Detail By All Options 

 Ins. Priority drop down list added to top section of Parameters tab. 

 New field has also been added as an option on the Group/Sort and Columns tabs. 

 

 Three new columns added for “Billing Register Detail By All Options” report. 

o Reports>Billing>Billing Register>Detail By All Options 

 Three new items added to Columns tab: 

 Case Description 

 Case Note 

 Claim Note 

o The case description and the case note are pulled from the patient case master screen and claim note 

is pulled from the charge posting screen. 

 

 Graphical Analysis Report added. 

o Reports>Billing>Medi Reports>Graphical Analysis Report for Bill 

 Option added to generate report based on Created Date, Actual Date or Claim Date. 

 Sort drop down now contains a “Charge” option. 

 Graph drop down allows user to select from several different graph styles. 

 

27. Dashboard 
 Default From option added to link dashboards to commonly used screens. 

o Setup>Admin>Dashboard 

o Default From column added with drop down list containing: 

 Check In/Out 

 Schedule 

 Charge Posting 

 Receipt 

o  Select one of the listed screens to link the selected dashboard to that screen. 

  button appears on the action toolbar of the linked screen, which can be clicked to open the 

default dashboard. 

 

 Default Dashboard – users who have not set up a dashboard will now automatically have default dashboard 

settings pulled from the dashboard set up for the System user.   

o This will prevent the user from getting the “Dashboard not set” indicator. 

o Dashboard settings for System user will come already set by default when the system in installed. 

 If these default settings are changed, the revised settings will be used as the default 

dashboard for users created after that point.   
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 New CI/CO dashlets added. 

o Setup>Admin>Dashboard 

 Click the  icon to open the “Select Dashlets” window. 

 5 new dashlets added in the “Check In/Out” section. 

 Time Spent Checkin To Check-Out (By Office) 

 Time Spent Checkin To Check-Out (By Provider) 
These two dashlets are based on Check-in time and Check-out time. 

 

 Time Spent Checkin To In-Room (By Day) 
This dashlet is based on Check-in time and In Room time. 

 

 Time Spent In-Room to Check-Out (By Office) 

 Time Spent In-Room to Check-Out (By Provider) 
These two dashlets are based on In Room time and Check-out time. 

 

 Skin Test option added for Visit Note Dashboard 

o Setup>Visit Note>Design Dashboard 

o Click the Options button at the bottom of the window. 

 Skin Test is now listed, and user can check the box in the “V” column to have it show in 

dashboard. 

o After setting this option, it can be seen in the Visit Note screen, by clicking Dashboard in the right-

side panel (Option>Dashboard). 

 Skin Test panel contains information for both prick tests and ID tests. 

 

 Vaccine option added for Visit Note Dashboard 

o Setup>Visit Note>Design Dashboard 

o Click the Options button at the bottom of the window. 

 Vaccine is now listed, and user can check the box in the “V” column to have it show in the 

visit note dashboard. 

o After setting this option, it can be seen in the Visit Note screen, by clicking Dashboard in the right-

side panel (Option>Dashboard). 

 Vaccine panel contains Vaccine name, Concentration, Prepared Date, and First-Last Shot 

Dates. 

 Click on the “Vaccine” panel label, or  > Open, to open the “Vaccine Prescription” 

window. 

 

28. Misc. Values 
 Misc. Values types will be kept on the list even if the last value entry for that type is deleted. 

o Setup>Other>Misc. Values 

o The Types listed on the left will now remain on the list even if its last value line on the right is 

deleted. 

 Previously, if the last value entry on the right was deleted, the Type on the left was removed 

from the list after the user clicked Save. 

 

 Dose Form (Drug Unit) section added in “Misc. Values” window. 

o Setup>Other>Misc. Values 

o Dose Form (Drug Unit) section added. 

 Items in this list will populate the drug Dose Form and Unit fields anywhere in the system 

that a medication is prescribed or medication details are selected. 
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 The fields were previously populated by hard coded lists that could not be added to. 

 Users can modify the list using the Add and/or Delete buttons. 

 

  Added Referral Source Type to misc values list. 

o Setup>Other>Misc. Values 

o Consists of 5 system defined values only: 

 Individual 

 Company 

 Patient 

 Seminar (this value only applicable to Cosmetisuite) 

 Other 

o System values cannot be modified or deleted. 

o Click the Add button to add user defined values. 

o Click the Delete button to delete a user defined value. 

o Populates the drop down list for the Type field in  

Setup>Payer/Medical Service/Reference>Referral Source. 

 

29. Marketing 
 Referral Source and Show Graph options added. 

o Activities>Marketing 

 Referral Source option added to By drop down list. 

 When this option is selected the Marketer field is hidden. 

 Show Graph check box has been added to provide the option for viewing a graph of the 

retrieved data. 

 This checkbox is only visible when the Report field is set to “Top (n)”, and after the 

data has been retrieved. 

 

 Marketing – added capability for marketing reports sorted by Referral Type. 

o Specific to Cosmetisuite 

o Activities>Marketing 

 Report = “Lead Conversion” or “Lead Activity” 

 By = “Referral Source” 

 Report View field appears. 

 No Group – Report will be displayed without any grouping. 

 By Counselor – Report will be displayed with grouping by Counselor, as 

before. 

 By Ref. Type – Report will be displayed with grouping by Referral Source 

Type. 

 

30. Patient Portal 
 Patient Portal login – ability to create a patient login for the portal, from “Patient Master” screen. 

o Click the Other Options icon in the right-side panel and select Portal Login. 

 This will open the standard “Patient Portal>Login/Email” screen, that is normally opened 

from Utilities>Patient Portal>Login/Email. 

 

 Patient Portal Login screen – added the Active checkbox to the right of the User Id. 

o Check box will only appear after the login has been created for the first time. 

o Uncheck box to de-activate the patient’s portal login. 

o You do not have to choose the email or letter option when activating/de-activating an existing 

patient portal login. 
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 Utilities>Patient Portal>Form Import – added two new filter fields. 

o Patient – limit the items shown to a particular patient. 

o Status –  

 To Be Imported – items not yet imported 

 Imported – items that have already been imported. 

 The Import button will be disabled when the filter is set to “Imported,” since items 

cannot be imported again, 

 

 Utilities>Patient Portal>Import – added Payment tab to import online payment entry records from the web 

portal. 

o Patient, From/To date, and Status filters are available. 

o Click Move to IMS button to import selected payment records into IMS. 

 Payment records can only be imported once. 

 

 Utilities>Patient Portal>Import – added Vitals tab to import vitals into IMS. 

o Patient, From/To Date filters are available. 

o Click Move to IMS button to import selected vitals into IMS. 

 

31. Miscellaneous 
 Show Global Period – users can now set a visible Global Period on a CPT code.   

o For certain procedures, such as surgery, if a patient has two visits for that same CPT within a certain 

amount of days, the 2
nd

 visit cannot be billed. 

o Setup>System Parameters>Bill General>“Show Global Period” 

 Set this parameter to “Yes” to have the Global Period field appear in the “CPT Code” and 

“CPT Parameter” screens. 

 Setup>Bill>CPT Code 

 Setup>Payer/Medical Service/Reference>Insurance Carrier – click CPT Parameter 

icon in right-side panel. 

o Global Period should be entered in days. 

o After Global Period has been setup for a CPT code, post a charge for that CPT to a patient account. 

 The Global Period information will now be displayed for this patient if that CPT is entered 

again within the set global period. 

   
 Shows - days remaining (end date of global period for previous charge) 

  Will be shown in: 

 Charge Posting (F6) – bottom right of screen below the “Insurance” section. 

 Scheduler (F9)>Schedule Entry window - appears below the Race field in the 

“Patient” section. 

 Check In/Out (F10)>Check In window – appears next to Patient Balance at the 

bottom right of the window. 
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 Followup Note – user can now enter a patient specific followup note from the “Patient Note(s)” screen. 

o Click the Notes button on the main IMS toolbar… or Activities>Note. 

o Type drop down has new “Follow-up” option. 

o Enter the rest of the note information as normal, and then save. 

o Patient Follow-up note can be viewed from: 

 Patient Ledger (Ctrl+F6) (Billing>Patient Ledger)  

 Mouse over red flag icon  that will appear to the right of the “Balance” in the orange 

header bar.  

 Right-click the appropriate ledger item row, then select Collection Followup>Patient. 

 Collection (Ctrl+F9) (Billing>Collection) 

 Summary view – click red flag icon  that appears under the Patient Followup 

column (Grp.By cannot be set to “Patient). 

 Detail view - click red flag icon  that appears next to patient’s name in the Patient 

column (Grp.By cannot be set to “Patient). 

 Right click a row and select Followup (Patient). 

 Other – The patient follow-up note can also be viewed anywhere that normal patient notes 

can be seen, such as Chart View>Notes, Visit Note screen, Reports on patient notes, etc. 

 As with other patient notes, it will also appear on the Patient Alerts window based on 

any Alert options selected when creating the Follow-up note.  

 

 License Detail – link added in “Employee/Provider” window to access license information. 

o Setup>Office>Employee/Provider 

o “License Detail” link added to the top of the window.  Click the link to see a popup window 

displaying license information. 
 

 
 

 Save Criteria - User now has the ability to save pre-defined search criteria, to make searches easier/faster. 

o “Save Criteria” added as a right click option on search criteria panel in most tracking screens. 

o Added to following screens: 

 Charge Posting (F6) (Billing>Charge Posting) 

 Claims (F7) (Billing>Claims) 

 Rebill Claims (Billing>Rebill Claims) 

 Claim History (Billing>Claim History) 

 Hold Claims (Billing>Hold Claims) 

 Hold Claims History (Billing>Hold Claims History) 

 A/R Activities (Ctrl+F9) (Billing>A/R Activities) 

 Authorization Tracking (Activities>Authorization Tracking) 

 Referral Tracking (Activities>Referral Tracking) 

 Eligibility Tracking (Activities>Eligibility Tracking) 

o Open any of the screens listed above, enter some search criteria and then right-click in the orange 

area of the search criteria panel. 

o If no previous searches have been saved user will see  option. 
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o The “User Defined Criteria” window will pop up, and user needs to fill in at least Description, to 

save the search. 
 

 
 

 Seq No. – if there are other saved searches, number to determine order in the list. 

 All Users – check is search should be available to all other users 

 Default – check if this set of search criteria should be used as this users default search. 

 Description – Enter a descriptive name for this search 

 Charge From/To – use these fields to set a certain time period. 

 These fields might be labeled a bit differently depending on the screen in which the 

search is being saved. 

o After at least one search has been saved a slightly different right-click menu will appear. 
 

 
 

 Section 1 – all saved searches (except the one currently loaded) will be listed here.  Click a 

saved search to load its criteria into filter fields. 

 Section 2 – Options for the currently loaded search.  Here the user can Reselect Criteria, 

Delete Criteria or Update Criteria for the currently loaded search. 

*selecting the Delete option here will delete the saved search entirely. 

 Section 3 – Save As allows the user to save a completely new search using the criteria 

currently selected. 

 Section 4 – Manage User Defined Criteria opens the “User Defined Criteria” window: 
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 Use the Seq. No. column to put the searches in the order they should appear on the 

right click menu. 

 Use the D column to designate a default search that will load automatically when the 

screen is opened. 

 Default checkbox can only be checked for one saved search. 

 Put the cursor in the search name, and click the Delete button to delete a saved search. 

 Click Save, and then Close, to save changes and exit the window. 

 

 Main Menus - when at menu the top of the IMS main window (Action, Setup, Activities, Billing, etc.) is 

clicked to expand it, the menu name now shows in a vertical label running down the left side of the drop 

down menu. 

 

 Admin option added to Setup drop down menu. 

o Setup>Admin – admin section is now accessible directly from the Setup drop down menu. 

 

 Changed format for date fields from MM/DD/YYYY to MM/DD/YY throughout system, except for DOB 

fields. 

 

 Added Printer button  in most places where printing of letters, forms, etc. is done. 

o Clicking this button opens a standard printer dialog window, where the user can select a specific 

printer, etc. 
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 Carrier field added to “Provider(s) Billing Under Group(s)” window. 

o Found in: 

 Setup>Office>Provider Group – click Provider icon in right-side panel. 

 Setup>Office>Employee/Provider – click Provider Group icon in right-side panel. 

 Setup>Payer/Medical Service/Reference>Insurance Carrier – click Provider Group icon in 

right-side panel. 

o User can now select a specific Carrier when setting up a provider billing under a group. 

 After IMS version upgrade, Carrier field will be defaulted to “All” for existing rows. 

 When a new row is added, the user will need to make the appropriate selection in the Carrier 

field. 

 

 Multiple Select search screen added to search filters: 

o Added in following screens: 

 Batch status summary report: 

 Collection 

 To be billed 

 Level 2 Reports 

 Quick Bill 

 Eligibility Tracking 

 Hold/ Hold History 

o Fields that are affected in these screens will no longer have a drop down list format. 

 Field background color will be blue. 

 “(?)” will be at the end of the field label. 

o To activate search window user can: 

 Click the field label. 

 Click the “(?)” at the end of the field label. 

 Click cursor in the blue area of field and then press F5. 

o In the Search window, the search results area has two sections: 

 Left side will show results of search. 

 Click one or more line items to select 

 Hold down Shift and press UP or DOWN arrows to select multiple 

consecutive line items. 

 Select All / Deselect All options provided 

 Click the arrow to move it to the right side. 

 Right side lists all items that have been selected. 

 To remove items from right side, click to select item(s), then click the Clear Selected 

option. 

 Hold down Shift and press UP or DOWN arrows to select multiple 

consecutive line items. 

 Click the Clear All option to remove all items from right side. 

 

 Visit Note alert option has been added to Patient Notes and Reminders. 

o “VN” checkbox has been added to the “Alert” section on the “Patient Note(s)” and “Reminder 

Task” screens. 

 “Immunotherapy” checkbox label has been changed to “AShot” due to spacing. 

o The standard “Patient’s Alert” window will open automatically anytime the “Visit Note” screen is 

opened for this patient. 
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 Security Parameters – added two new security parameters. 

o Setup>Security>Parameters button 

 Reset password every (n) days – requires users to create a new password every time the 

specified number of days passes. 

 Do not allow the same password from last (n) passwords – prevents users from using the 

any of the same passwords from the last specified number of resets.  

 

 Security settings added for Clearing House and Insurance Code Master screens. 

o Setup>Security>Grants tab 

 Setup > Bill > Clearing House 

 Setup > Bill > Clearing House (Add) 

 Setup > Bill > Clearing House (Delete) 

 Setup > Bill > Clearing House (Edit) 

 Setup > Bill > Insurance Code Master 

 

  IMS Directory screen changes: 

o Contact types are now displayed in a tree format on the left, instead of a drop down box at the top. 

 Types are sorted into two categories: System 

Pt. Contact Types 
 Double click the contact type to view the list of contacts. 

o The right side of the screen will display the list of contacts for the selected type. 

 Entries will be displayed in alternating blue and white rows for visual distinction. 

 “Search” field – type a few letters or a word to jump to any matching entries in the list being 

viewed. 

 Double click an entry to edit the contact record. 

 Click the “Add” button to create a new contact record in the selected type. 

o Action toolbar now contains only the Print, Navigation and Exit buttons. 

 

 Import Fee Schedule - Added the ability to import a fee schedule. 

o Setup>Bill>Fee Schedule 

o Import button added at bottom, opens “Import Fee Schedule” window. 

 Click Browse button to select external fee schedule file. 

 Only files in .csv format can be imported. 

 Hover over “Sample File” help icon 

 Click Load button to pull data into window. 

  Select all CPT lines to be imported 

 Select All / Deselect All buttons are available. 

 Click Import button to pull data into IMS fee schedule. 

 

 Document Viewing Program – allows users to designate a specific program for viewing non-standard 

image files. 

o New screen added in Setup>Admin>Set Document Viewer 

 Extension – enter the file extension, such as “DAR” 

 Computer/Computer Group/Office –  

 Part 1 - choose what to make this setting specific to:  Computer, Group 

 Part 2 – choose the appropriate computer/group based on Part 1 setting. 

 Program – click the  icon to select the executable file for the appropriate program, such 

as notepad.exe. 
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 Parameters – users can enter parameters that may be able to be passed to the chosen 

program. 
 <record_id> - TRAN_ID from table where document is linked 

 <document_id> - TRAN_ID from patient document 

 <patient_id> - ID from patient master 

 <chart_no> - Patient’s Chart No 

 <lastname> - Patient’s Last Name 

 <firstname> - Patient’s First Name 

 <file> - Associated File 
 

 Referring Provider – added two new fields for Practice Name and Contact #. 

o Setup>Payer/Medical Service/Reference>Referral Doctor 

o Practice Detail section added with 2 new fields. 

 Name – enter practice’s name. 

 Contact # - enter general contact number for the practice. 

o New fields are available for use in Letter Templates & Forms (To be filled). 

 Field List>Referred By>Ref. By Dr. Practice Name 

 Field List>Referred By>Ref. By Dr. Practice Contact 

 

 Emailing Documents now includes two additional options. 

o Utilities>Patient>Document 

o In the “Patient Document(s)” window, select the appropriate document(s) and click the Email button 

at the bottom of the screen. 

 The “Email” popup window has two new checkboxes available at the bottom. 

 Add Signature 

 Zip Files 

 

 Fax # added as a search option in Contact & Referral Doctor screens. 

o Setup>Payer/Medical Service/Reference>Contact 

Setup>Payer/Medical Service/Reference>Referral Doctor 

 Click the Search button or press Ctrl+H to open the search window. 

 Fax # has been added to the search options listed in the left-side panel. 

 

 Print Label checkbox option added to the “Select Letter Template” window.  Applies to batch printing of 

letters (multiple items selected, then click the Print button) from these screens: 

o Authorization Tracking 

o Referral Tracking 

o Marketing 

o Reminder 

o Patient Special Search 

 

 Case field has been added to several screens: 

o Reminder Task 

o Fax Received  

o Patient Note(s) 

o Multi Scan/Select>Set Detail (“Assign Documents to Patient” window) 

o Patient Documents>Go to Detail 
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 Allergies – Reaction field is now a drop down list that can retain previous entries. 

o “Patient Master” screen>Allergy icon in right-side panel. 

“Visit Note” screen>Drug Allergy in left-side panel>click Add button. 

 User can select an existing entry from the drop down list. 

 User can type in a new entry. 

 System will display a prompt asking if the new entry should be added to the list. 

 The Reaction field is a single select drop down, so if more than one reaction needs to be 

listed, the user will need to type in an entry containing a combination of reactions (ex.  hives, 

difficulty breathing and sneezing).  This combination can also be saved as an entry on the 

list. 

 

 Flowsheets – ability to include VN Template Question, Office Lab Result, and Vital Signs. 

o Add/Update Flowsheet icon  added to 3 screens: 

 Template Question Customization – (ex:  Setup>Visit Note>Procedures)  

 Icon added to top right corner of Main tab in middle panel. 

 Opens “Flowsheet Columns” window. 

 Select appropriate flowsheet in list on left. 

 Select Enter Value, Description, or Sub Level option in drop down at top of 

window. 

  Enter the appropriate sequence number in the Seq. # field in the column 

details at the bottom of the window, to designate the order in which this 

column should appear on the flowsheet. 

 The rest of the column settings will be automatically set to the correct values. 

 Click Save to add/update the column to the flowsheet. 

 Diagnostic/Lab Test – (Setup>Visit Note>Diagnostic/Lab Test) 

 Icon will appear at the end of each line item in the Observation tab. 

 Opens “Flowsheet Columns” window. 

 Select appropriate flowsheet in list on left. 

 Enter the appropriate sequence number in the Seq. # field in the column 

details at the bottom of the window, to designate the order in which this 

column should appear on the flowsheet. 

 The rest of the column settings will be automatically set to the correct values. 

 Click Save to add/update the column to the flowsheet. 

 Vital Options – (Setup>Visit Note>Vital Options) 

 Icon will appear at the end of each vital option line. 

 Opens “Flowsheet Columns” window. 

 Select appropriate flowsheet in list on left. 

 Enter the appropriate sequence number in the Seq. # field in the column 

details at the bottom of the window, to designate the order in which this 

column should appear on the flowsheet. 

 The rest of the column settings will be automatically set to the correct values. 

 Click Save to add/update the column to the flowsheet. 
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  SMS/Email 

o Setup>Security>Grants 

 “Setup > Other > SMS/IVR Default Templates” changed to “Setup > Other > SMS/Email 

Default Templates” 

o Setup>Other> 

 “SMS/IVR Default Templates” changed to “SMS/Email Default Templates” 

 Window has been changed slightly 
 

 
 

 Type – SMS or Email 

 Category - 

 Patient Notes 

 Reminder Setup 

 Health Maintenance 

 Reminder Task 

 Language – select language for message 

 Template – select the letter template to use for message. 

 Drop down list will only contain letter templates with Type = SMS 

o Setup>System Paramters>Other 

 SMS to be sent between – set the time range in which the SMS messages should be sent. 

 Timezone of SMS Application Server – select the timezone of the client that should apply 

to the time range set in the above parameter. 

o Activities>Reminder> Setup  

 Task tab 

  changed to , and now brings up slightly changed “SMS” window. 
 

 
 

 SMS icon turns green  when setup for a task. 

o Activities>Reminder>Add 

  changed to , and now brings up slightly changed “SMS” window, as seen 

above. 



IMS v14 Release Notes 
 

62 

 
 

 

 Auto Checkin – hotkey added to open auto check in screen for immunotherapy visits. 

o While in the Check In/Out (F10) screen, press Shift+F8  

 It will open the “Auto Check in” window with only the "Please scan your card" field 

showing. 

 Scan the patient’s card 

 If valid, it should Auto check-in the patient as an Immunotherapy visit, and then 

return to the previous window. 

 If patient doesn’t have an appointment, it will auto check-in as a Walk-in. 

 It should revert back to original window after 15 seconds.  

 

 Status Bar changes- changes to the status bar at the bottom of the main IMS program window. 

o The Time will not be shown. 

o The Build (.exe) Date will be shown in a separate section than the version. 

o (R) will be shown next to the computer name if IMS is being accessed by a remote computer. 

 

 Contacts – system will now allow more than one contact to have the same email address. 

o Setup>Payer/Medical Service/Reference>Contact 

o If an email address (ex:  person@contact.com) is already entered for one contact, and the user enters 

exactly the same email address for another contact, when they click Save, the system will display a 

prompt stating: 

 “Record with the same Email already exists in the system, Do you want to go to that record?”  

 Yes – the contact that already has that email address will be loaded, and the email will not be 

saved for the other contact. 

 No – prompt will close and the email address will be saved for that contact. 

o Patient Master>Contact icon in right-side panel 

 When adding/editing contacts through this window, the process will be the same as described 

above. 
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